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Note: Colors are not controlled by this program. They are controlled by your settings in the Control 
Panel, usually found under the Accessory Group in the Program Manager.



Family Photo Album Features Overview
Create your own Photo Albums with this exciting program! With Family Photo Album you can create an 

entire book/album with your scanned photographs. 

 Unlimited number of albums can be created.

 Each album can consist of up to 1,000,000 chapters.

 Each chapter can hold up to 250 scanned images (PCX, BMP, GIF, JPG, WMF, or ICO).

 Each photograph can include a caption.

 Each chapter can also include a large 64,000 character story note. The text editor includes a Spell 
Checker.

 Print out your album with regular or large photographs. You can include a Title Page and Table of 
Contents.

 A sample album is included with the program.



Getting Started
If you want to simply start your own album without going into all the details contained in the help file then 

simply follow these steps:

1. After starting the program create a New Album from the File menu. Enter an album name - up to 8 
characters or digits. Do not enter an extension.

2. Enter a password for your album, if desired. If you do not wish to use a password, then simply leave 
the field blank. The Main Album Window will then be opened.

3. First enter your name and address in the User Information dialog box by selecting User Information 
from the Edit Menu. Also enter a name for your album. After you exit this dialog, you will see your 
name and album title in the title bar of Family Photo Album.

4. You should now use Windows File Manager or the DOS copy command to place all of your scanned 
images into the sub-directory created for your album. Suppose that Family Photo Album was installed 
to a directory called C:\FPA and that you called your album LUND. A sub-directory called LUND would 
have been created in the C:\FPA directory, therefore you should copy all your images to the C:\FPA\
LUND sub-directory.

5. You are now ready to add your first chapter. Select the Add Chapter button. Enter a chapter heading 
and press Ok.

6. From the Photo Selection Window you can select from the list of Available photos to add to the new 
chapter. Type in a caption under each photo as you go along.

7. You can also press the Edit Story Note button and add a story about the photos for this chapter.

8. Repeat this process for each chapter you wish to be included in your album.

9. Finally to print your album, click on the Print Icon. Indicate the appropriate options you wish included in 
your printed album.You may preview the printed document before sending it to the printer.

This should get you started. As you work with the program you will find many more useful and exciting 
options that will enhance your work with Family Photo Album.





Main Application Menu
Upon first starting Family Photo Album you will see the Main Application Menu which consists of only 
THREE menu items: File, Options and Help.

The File Menu contains the following three options (in addition to the Exit option):

New Album
Select this option to create a new photo album. You will be prompted to enter an album name and a 
password (if desired). A new sub-directory with the album name will be created within the main program 
directory. This directory will hold all Album files. If you do not wish a password, simply leave the password
field blank. You should also copy all scanned photos for that album into the newly created sub-directory.

Open Album
This option will allow you to open an existing photo album. If the album requires a password, you will be 
prompted for it.

Delete Album
You may delete albums with this option. Be very careful, as once an album has been deleted, you cannot 
recall it.

The Options Menu is the same as shown under the Main Album Window.



The Main Album Window
The main window contains a list of the chapters in your album. From here you may press any of the 
following buttons:

Add Chapter
Pressing the Add Chapter button will create a new chapter which will be inserted after the chapter which 
is currently highlighted. You will first be prompted to enter a chapter heading. Then you will be presented 
with the Photo Selection Window where you indicate which photos are to be used with the current 
chapter.

Edit Chapter
This button allows you to edit the currently highlighted chapter. You will be immediately presented with the
Photo Selection Window where you may change or edit the photos, captions, chapter heading or story 
note.

Remove Chapter
This button will delete the currently highlighted chapter. Scanned image files will not be deleted, only 
references to them within the removed chapter will be deleted. Any story notes and captions associated 
with that chapter will also be deleted.

Move Chapter Up and Move Chapter Down
You may change the order of the chapters by pressing these buttons to move the currently highlighted 
chapter up or down from its current position. You may alternatively press the U and D keys to execute 
these commands.



Photo Selection Window
Here is where much of your work will be accomplished. After creating your database, you should copy all 
scanned images and photos which you wish to include in your album to the album sub-directory. Suppose
that Family Photo Album was installed to a directory called C:\FPA and that you called your album LUND. 
A sub-directory called LUND would have been created in the C:\FPA directory, therefore you should copy 
all your images to the C:\FPA\LUND sub-directory.

Family Photo Album will accept scanned images in any of the following formats: PCX, BMP, GIF, JPG, 
WMF, or ICO.

Scanned images can take a lot of disk space. There are many variables that will control the quality of the 
images you scan. An SVGA monitor will give you the best screen pictures. A Laserjet printer with 600 dpi 
(or better) will give you the best printed output. The popular Hewlitt-Packard Laserjet 4 is an ideal printer 
for this. When scanning images you will be making a trade off between picture quality and file size. 
Scanned images can take a lot of space. If you print the normal size photos, then scanning an image to 
be saved as a PCX file with a height of 1¾ inches produces a file about 50-60K (color photo 256 colors). 
If you are printing the large photos, you will get more detail by saving it to be 3 inches high. In either case,
the width will float. Narrow pictures will take less disk space than wide pictures.

Pressing the Select button on the left below the list of available photos will copy the image file name to 
the list of selected photos on the right. There you can also add a caption (max of 1,000 characters).

You may also move the highlighted photo up or down by pressing the appropriate button. The Remove 
Photo button does not delete the photo image. It only removes the reference to that image. That photo 
will still be in the available list for another chapter if desired.

From the photo selection window you can also edit the chapter heading and edit any Story Notes.



Edit Story Note
This program does not support full Word Processing capabilities, such as changing the font of selected 
text. The text normally used is the standard Arial font that comes with Windows 3.1. The tab key is not a 
true one-character tab. It is implemented as a macro - placing several spaces directly into the text.

The Edit Menu allows you the normal cut, copy and paste operations. There are also icon buttons that 
implement these functions. By highlighting a segment of text you can cut or copy that text to the Windows 
Clipboard. The paste function will copy the contents of the clipboard to the current insertion point. Thus 
you can cut, copy and paste between Family Photo Album and other Window applications.

You may also Close the Story Note Window from the Edit Menu.

There is also a second menu item on the Story Note Window: the Spell Check Menu.



Spell Check Menu
Check Word, Check Entry
These options will check the spelling of words in your story note entry. Check Word checks the spelling 
of the word at the cursor insertion point. Check Entry will check all words beginning at the cursor location
to the end of the current note. (Press Esc at any time to cancel the spellchecking.) There are Icons on the
ToolBar for these two items.

Edit Custom Dictionary
In this dialog you may add, edit and delete words from your own custom dictionary (CUSTOM.VTC). Of 
course, words may also be added automatically to the custom dictionary while you are running the spell 
checker.

Edit SpellCheck Options(These options are explained under another help topic. Click on the words above 
to immediately jump to that topic.)



Spell Checker Options
There are a number of options that control the way in which the spell checker verifies the spelling of your 
words. These options can be modified by selecting this item from the SpellCheck menu or by selecting 
the Options... button in the Spell Check dialog which appears every time an unknown word is 
encountered during the spell check process. Each of these options are explained below:

Automatic Suggestions
Checking this option will cause a list of suggested words to be appear when an incorrectly spelled word is
found. This option is normally checked.

Exact Match Required
Checking this option will require that capitalization of all words match exactly. In normal usage words are 
often written sometimes with all caps, first letter capitalized, etc. Therefore this option is normally NOT 
checked.

Ignore Full Caps
If this option is checked, the SpellChecker will NOT check words that are all in caps. Normally this option 
is NOT checked.

Ignore Partial Numbers
If this option is checked, words with intermixed alpha and numeric characters will NOT be checked. 
Normal such words are mistakes and should be caught by the spell checker. However, there are time you 
might add such words (like serial numbers) to your custom dictionary. Therefore you may wish to check 
this option, which is normally not checked.

Ignore Pure Numbers
This option is normally checked. If it is not checked, a pure number will be checked against the dictionary 
and shown as incorrect if not found. There are no pure numbers in the standard dictionary. Therefore, 
they will only be found correct if you add them to your custom dictionary.

Allow Joined Words
If this option is checked, then a word joined with a hyphen will be considered correct if the two component
parts are spelled correctly. Otherwise, a hyphenated word will only be considered correct if the entire 
hyphenated word is found in one of the dictionaries.

Recheck Typed Replaces
After you have typed a correction in the Replace with: entry, the spell checker will recheck the typed 
correction if this option is checked. Normally you would want this option to be on.

Open Custom, Open Standard
Normally the program will open and close the custom (CUSTOM.VTC)and standard (AMERICAN.VTD) 
dictionaries. The custom dictionary is provided for you to add your own words. If you close one of these 
dictionaries, the spell check will not check words against that dictionary. It is suggested that you never 
change these options. The results will be unpredictable.

Performance
There is a trade-off between memory usage and performance which can be adjusted with this option. To 
get faster performance, you can load more words in to memory by sliding this control to the right.

Suggestion Search Limit
Whenever a misspelled word is encountered, the spell checker runs through a complicated algorithm 
searching for possible correctly spelled words. This limit is the number of possible letter combinations that
will be tested. However, regardless of how high this number is, the maximum number of final displayed 
suggested words will always be limited to 10 words.





File Menu
The File Menu consists of the following items. (Note that only one album may be open at a time. Thus the 
New Album, Open Album and Delete Album Items are not available until the current album is closed.)

Close Album
This item will immediately close the album and return you to the Main Application Window.

Clear Album
This item will clear the current Album. It will not remove or delete any of the scanned image files. It will 
only remove all records from the album and photo data files. You will be warned about clearing your 
album. Be careful - once you have cleared an album, you will have lost all the chapters, captions and 
story notes that were in that album.

Print Setup
With this option you may set two parameters for printed reports:

1. Paper Size may be set to US letter (8½ x 11 inches) or A4 international. The program was developed 
using US letter size paper with three-quarter inch margins. When selecting A4 paper size the printing is 
essentially extended an additional amount so there will be less wasted space at the bottom of the page.

2. Page numbers may be set to print on right side only or to print odd numbers on right and even on left. 
For singel sided pages you would normally print all page numbers on the right. For eventually printing 
reports double-sided it will look better to select page numbers with alternating left and right sides.

Print (This option is covered under another topic.)

ASCII Text Import
When you select this a dialog box will prompt you to enter or select a file. The file will be immediately 
imported to the Windows Clipboard. You may then Paste the text from the file to any Story Note.



Print
This option allows you to select the chapters of the album that you wish to print. You may also include a 
Table of Contents and/or Title Page. You may also specify the beginning page number. The Table of 
Contents will only be generated for the chapters that are printed (and not necessarily the entire album). 
The diary needs to be printed first, in order to determine the page numbers to be included in the Table of 
Contents. You will notice that the page numbers are not included in the Table of Contents. The Table of 
Contents is meant to be placed at the beginning of the diary, which you need to do manually. It is printed 
after the diary in order to collect the page numbers while each entry is printed.

Normal sized photos are printed in three rows on a page (if no story note is included) and can print from 
9-12 photos per page (depending on width of photos). Selecting Large Photos will cause printing of 
photos on only two rows per page (if no story note is included) and can only print 2-6 photos per page 
(depending on width of photos).

The Title and Footnote will be printed on each page and are initially copied from the User Information. 
However, once the Print Window has been accessed, any changes here will be saved for any subsequent
printing.

You may optionally Preview the printed report before sending to the printer. The Print Preview screen 
allows you to zoom in and out for a closer look. You may send the report to the printer either by Clicking 
on the Print Button On the Preview Screen or on the main Print screen.

If you intend to actually send the report to the printer it would be better to press the Print button rather 
than Preview then Print. This is because printing from the Preview Window does not give you an 
indication of how far along the printing is going - and the printing of photographs, especially large ones 
can really take a long time! Not only this, but large WMF files (such as are temporarily created with 
Preview and with photographs) can really take a lot of hard disk space, not to mention the space used by 
the temporary file created for Print Manager.    In Windows, a report wont actually start printing on the 
printer until the entire report has completely been sent to the Print Manager.

From the Print Preview Window, there is also an option to save the report as Window Meta Files (WMF). 
When a report is previewed, a temporary WMF file is created - one for each page. These temporary files 
will be erased whenever you exit the Preview Windwos. You may save these WMF files to a filename of 
your choosing.



Edit Menu
The Edit Menu consists of the following items:

User Information
In this dialog you may enter the your name, address and the Photo Album Title. You will notice that your 
name and Album Title will then be shown in the Family Photo Album title bar.

Password
With this dialog, you may change your password, or add a password to the current album, if it does not 
have one. Do not forget your password!



Tools Menu
The Tools Menu consists of the following items:

Scanned Image List
This handy tool will produce a report in two parts:

1. A list by chapter of the images associated with each chapter.

2. A list of all image files in the album sub-directory not used by any chapter.

You may also print out this report.

Rebuild Key Files
This option will rebuild the Key (Index) files assocaited with the two main data files of your album. In 
normal operations the album and photos key files will not need to be rebuilt. If, however, you see some 
strange things, such as chapters out of order, etc. it may be possible that the key files need to be rebuilt. 
You may rebuild the key files at any time. It never harms a thing and may help.



Options Menu
The Options Menu consists of only one item:

Program Configuration
This option allows you to specify an album to be automatically opened upon program startup. This item 
can also be accessed once an album is open and can be changed at any time. If left blank, you will be 
presented with the Main Application window on program startup. If a valid album name is entered here, 
then that album will be automatically opened on program startup.





Scanning Images
There are basically two ways to get your photos into the Family Photo Album:

1. Use your own scanner to produce an image file in one of the following formats: PCX, BMP, GIF, JPG, 
WMF, or ICO. If you plan on printing normal size photos, then scanning to about 1¾ inch high images - 
color photo will produce approximately 50-60K size files. If you plan on printing Large photos then 
scanning to approximately 3 inch high images will produce about 100-120K size files. These are the 
recommended sizes for optimum quality vs. file-size trade-offs.

2. Send your photographs to Cumberland Family Software and have them create image files for your 
Photo Album. Unless regular size images are specified, all photos will be scanned to 3 inches high (PCX 
format), producing 100-120K files on average. If detailed instructions are included for cropping then we 
will crop the photos for you. When compressed, this will allow about 16-24 photos to be included on one 
1.44M High Density 3.5 inch disk. Prices for scanning photos are listed below:

(A $16 order minimum is required - diskettes are included)

1-24 photos $1.60 each
25-49 photos $1.40 each
50-99 photos $1.20 each
100+ photos      $1.00 each

Please add $3 postage to the entire order (for US/Canada)
(outside US/Canada add $7 postage).

Cumberland Family Software
385 Idaho Springs Road
Clarksville, TN 37043
(615) 647-4012

In order to access your images you must copy your image files to your album sub-directory within the 
main Family Photo Album directory. For example, if I were to add more image files to my sample album, 
then I would copy the image files (using File Manager or the DOS copy command) to the following sub-
directory: C:\FPA\SAMPLE.



Known Problems
Here is a list of current known problems which may or may not be fixed in future versions. Some of these 
problems are due to the programming environment.

* With some video cards, printing to a printer from the Print Preview Screen causes very small text to be 
printed. If your computer has this problem you can avoid it by always printing to the printer from the main 
Print window, rather than from the Preview window.

* If you Alt-Tab to another application and then Alt-Tab back to Family Photo Album, the keyboard may not
function correctly. If this is the case, you will need to use the mouse to change to a different window and 
then you should be able to use the keyboard again.



Trouble Shooting
Technical Support - Phone: (615) 647-4012,      CompuServe: 70713,3476

Cumberland Family Software      385 Idaho Spring Road      Clarksville, TN 37043
Technical support may be obtained by phone, CompuServe and mail. Support is guaranteed for 90 
days after product purchase. The current policy is to offer support freely even after the 90 day 
guarantee period, but this policy is subject to change.

Most Problems are User Errors
Remember that nearly 80 percent of computer problems are caused by user errors. Before running any 
software, read the instructions. You don't have to read every word just to get started. You can find the 
sections of the manual that tell you how to begin, and those that apply to the task you are trying to 
perform.    With large manuals, there is usually a table of contents and an index. Skim these to familiarize 
yourself with the topics that are discussed.    Then you'll know where to look when you have a question.    
With shorter manuals go ahead and read the whole thing.    It's embarrassing to mail a long letter or make 
a long distance phone call, only to find that everything you needed to know was on page 2.

Before assuming a program "doesn't work", check a few simple items. Is the computer plugged in and 
turned on? Are all necessary devices (such as the monitor and printer) connected properly and turned 
on? Did you spell the command correctly when you typed it? Are you logged onto the right disk drive and 
directory? Is it possible that the program has system requirements that you don't meet, such as a hard 
disk, or a certain amount of memory? If memory seems to be the problem, do you have "memory 
resident" programs (also called TSRs or "pop-up" utilities) which can be removed from memory? Try 
running the program on a different computer.

If the program worked in the past, but doesn't now, can you think of anything that has changed since the 
last time you used it?    Have you moved the computer or made changes in any of the connecting cables? 
Is it possible there has been damage of some kind, or that files have been erased? Have you added any 
new memory-resident programs or device drivers which might cause a conflict?

Be Specific about your Problem
"It doesn't work" may sum up your feelings about a problem, but these words are useless if you need help
from a consultant or programmer. You can minimize frustration and save time by learning to provide 
specific details that will lead to a solution.

If you see an error message on screen, copy it completely and exactly. Don't try to remember it! If 
possible, make a print-screen of the message.    On most computers, you can do this by holding down the 
SHIFT key while you press the PRINT SCREEN key (sometimes abbreviated to PRT SC). The purpose of
the error message is to convey specific information to the programmer so that the problem can be solved.
Your consultant will need the exact wording of the message in order to interpret it correctly.

Many error messages include an explanation that can help you solve the problem yourself. Some error 
messages are explained for you in the program manual.    When reporting a problem, be very specific.

What were you trying to do?    How did you do it? What did you expect to happen? What actually 
happened?    Exactly what did you do just before the problem occurred? What did you do afterwards? 
What did you see on the screen? Have you had different or similar results in the past? Can you reproduce
the problem and describe the circumstances under which it occurs? Is there a consistent pattern of some 
sort?

I support my users, and am happy to answer your questions and help solve any difficulties you may have. 
Please understand that there is a limit to the amount of help I can give you with software which I did not 
write. If you are having continuing difficulty with DOS or Windows commands, you probably need to study 
your DOS or Windows manual or contact MicroSoft for help. If you are baffled by your menu system, your 



best bet is to talk to the person who installed it, or to the author of the menu software.



Family Photo Album Files
The following set of files come with Family Photo Album.

Distribution Disk On Hard Drive after Installation

INSTALL.EXE Installation program
INSTALL.INI Installation parameters
FPA.EXE Family Photo Album program
FPA.HLP Family Photo Album Help File
CW2RUN16.DLL Clarion programming language library
CW2CLA16.DLL Clarion File driver
CW2DOS16.DLL DOS File driver
CW2ASC16.DLL ASCII File driver
CWVBX.DLL Clarion VBX library
PERCNT2.VBX Percent Bar VBX - © Mabry
VTSPELL.VBX Spell Check VBX - © Visual Tools
AMERICAN.VTD American Spell Check Dictionary - © Visual Tools
CUSTOM.VTC Custom Dictionary - edited by user

There will also be a sample Photo Album installed with the following files:

ALBUM.DAT Main Album Data File
ALBUM.MEM Main Album Notes File
ALBUM.K01 Main Album Key File
PHOTOS.DAT Photo List Data File
PHOTOS.MEM Photos Captions File
PHOTOS.K01 Photos Key File
SAMPLE.INI INI Information File
FAMILY1.PCX Picture #1
FAMILY2.PCX Picture #2
FAMILY3.PCX Picture #3
FAMILY4.PCX Picture #4
NC01.PCX Picture #5
NC02.PCX Picture #6
NC03.PCX Picture #7
NC04.PCX Picture #8
IDAHO1.PCX Picture #9
IDAHO2.PCX Picture #10
IDAHO3.PCX Picture #11
SPEC1.PCX Picture #12
SPEC2.PCX Picture #13

Eventually you will notice one other file added by the program to your program directory:

FPA.INI INI file containing saved settings and options

Whenever you create a new album, the first six (ALBUM & PHOTOS) files will be created within a sub-
directory with the name you enter as the album name. You should then copy all scanned photos you wish 
to use with that album into the created sub-directory.



Backing Up
It is very important that you back up your Photo Album. A lot of work can be lost if your files become 
corrupted or lost in any fashion. There is no backup utility provided with this program - because there is a 
very nice Backup Utility already provided with Windows. It is called MSBackup and can usually be found 
in the Accessory Group in the Program Manager.



License Agreement
By accepting and using this software, you acknowledge that this software may not suit your particular 
requirements or be completely trouble free.    Properly applied this program should operate without error. 
However, I am not    liable for your specific application or problems resulting from its use.    If the software 
does not perform as described liability is limited to replacement of the program and refunding the 
purchase price.    There is no liability to you or any other person or entity for any damage or loss, including
special, incidental, or consequential damages, caused by this software, directly or indirectly.    Some 
states do not allow the limitation or exclusion of liability for incidental or consequential damages, so the 
above limitation or exclusion may not apply to you.    This license agreement is governed by Tennessee 
law.    If any part of this agreement is found to be held invalid, the remainder will remain in effect. This 
agreement may only be modified by the written consent of the author.



Shareware
This program (as well as other programs produced by Cumberland Family Software) is distributed through
the shareware channel. Shareware is a marketing channel, not a type of software. Shareware allows you 
to try a program out before you purchase it. Shareware is copyrighted and you should pay for the program
if you continue to use it after the trial period.

As a responsible member of the Shareware Industry, I ascribe to the following principles which I adhere to
in all my shareware programs:

1. I will treat my customers with courtesy and respect.

2. My programs will explain in advance how they encourage payment.

3. My programs provide ALL features with enough time to allow evaluation in typical usage.

4. My programs allow the customer access to all data within the program even after the evaluation 
period.

Cumberland Family Software is a member of Shareware Trade and Resources (STAR).

Cumberland Family Software is also a member of the Association of Shareware Professionals (ASP). 
ASP wants to make sure that the shareware principle works for you. If you are unable to resolve a 
shareware-related problem with an ASP member by contacting the member directly, ASP may be able to 
help. The ASP Ombudsman can help you resolve a dispute or problem with an ASP member, but does not
provide technical support for members' products. Please write to the ASP Ombudsman at 545 Grover 
Road, Muskegon, MI 49442-9427 USA, FAX 616-788-2765 or send a CompuServe message via 
CompuServe Mail to ASP Ombudsman 70007,3536.



Cumberland Family Software Products
Cumberland Family Tree for Windows (Estimated Release: September 1995)

Trace your family history with names, dates, places, extensive notes and photographs. Include source 
documentation and scanned documents. Produce a beautiful Indexed Book that will be a family heirloom 
for generations to come. Automatically produce stories with the Ancestral Story and Descendant Story 
reports. Includes 30 different types of reports! Powerful! yet easy-to-use!

Product Details $60.00 US

Cumberland Family Tree Professional (for DOS)
Trace your family tree with this Professional DOS family tree program. Include names, dates, places, 
notes and source information. Produce an Indexed Book and include any of more than 15 different types 
of reports.

Product Details $40.00 US

Family Photo Album (Windows)
Organize your scanned family photographs into an electronic photo album, add captions and story text for
each chapter and print out your personalized Family Photo Album!

Product Details $20.00 US

Cumberland Diary (Windows)
Keep your personal diary or journal on the computer

Product Details $20.00 US

Cumberland Diary (DOS)
Keep your personal diary or journal on the computer

Product Details $20.00 US

Cumberland Story (DOS)
Write your own or your ancestors life story

Product Details $20.00 US

JCSM Shareware Collection on CD-ROM
Three super CDs: Personal, Home & Office contains over 1500 programs; Educational contains over 
2000 programs; Games contains over 2000 arcade, adventure, action, board and card games! A real 
value for an inexpensive price!

$20.00 US each or all three for $50.00 US

To order any of these products call or write (or select Order Form from the Help menu):
For each order add $4 Shipping - US/Canada (Add an extra $3 Shipping to locations outside North 
America).

Cumberland Family Software
385 Idaho Springs Road
Clarksville, TN 37043



(615) 647-4012

VISA and Mastercard accepted



Cumberland Family Tree for Windows
(Estimated Release: September 1995)

Stories, biographies, photos and TWO manuals, including a sample index family history book 
created with Cumberland Family Tree for Windows! A powerful program!
Trace your family history with names, dates, places, extensive notes and photographs. Include source 
documentation and scanned documents. Produce a beautiful Indexed Book that will be a family heirloom 
for generations to come. Automatically produce stories with the Ancestral Story and Descendant Story 
reports. Includes 30 different types of reports!

Computer & DOS Requirements: Windows 3.1 or above, 4Mb RAM or more

Database Limitations: 1,000,000 names, 30 children per marriage, 12 marriages per individual

Names: 80 characters max with surnames allowed anywhere in the name - beginning, middle or end. 
Place Names can be up to 200 characters and need only be entered once! They can then be selected 
from a pop-up list forever after!    

Life Events: Each individual in your family tree may have up to 250 events! These events may include 
birth, baptism, marriage, death, burial, LDS events, occupation, immigrations, graduations, divorces, 
addresses, user ID tags, or any other event imaginable. Each event contains a date, a place, and a 
source note. Historical or explanatory notes (up to 32,000 characters - about 10 printed pages) may be 
attached to each event. (Thus, you could write a complete biography on a single individual - up to 2,500 
pages!) Source notes (up to 5,000 characters long) are also added to a separate list allowing the same 
source note to be easily selected from a pop-up list for other events and individuals. Text or scanned 
documents may also be attached as sources.

Photos: Up to 250 photographs may be attached to each individual.

Other features include: adoptions, Soundex Codes, user-definable flags, Relationship Calculator, Date 
Calculator, Documents, Tiny Tafel files and Industry Standard GEDCOM Import/Export. Included are also 
powerful utilities to split and merge databases.

Individual Notes may be up to about 20 pages (64,000 characters) using on-line text editor, which 
includes a spell checker. (This is in addition to the notes allowed on individual events.)

Reports include: 

Ancestral Reports: Ancestral Story, Ahnentafel, 4 Generation Pedigree (including cascading), 6 
Generation Pedigree (including cascading), Photo Pedigree.

Descendant Reports: Descendant Story, 6 Generation Descendant Chart, 14 Generation Descendant 
Chart, Photo Descendant Chart.

Lists: Individual Lists, Family Record Lists, Event Lists, Place Name Lists, Description Lists, Source 
Note Lists.

Other Reports: Family Group Chart (may include photos), Photo Album, Individual Summary, 
Statistics, Database Structure, Documents.

NOTE: Story type reports can include an annotated bibliography referencing all the source notes and 
documents.

An Indexed Book allows you to include all of the reports listed above (except for the Poster Pedigree). 
The Indexed Book creates an index of all names printed in the book and produces an index at the end 
showing which reports and page numbers where each individual is mentioned.

TWO Manuals come with this program!
Cumberland Family Tree Users Manual

1. Installation



2. Climbing Your Family Tree
3. Tutorial 
4. Detailed Reference      

 The Lund Family Heritage

A sample family history book created with Cumberland Family Tree for Windows, shows samples of every
report the program is capable of printing, with ideas on how to create your own family history book.



Cumberland Family Tree Professional (DOS)
Trace your family tree with this Professional DOS family tree program. Include names, dates, places, 
notes and source information. Produce an Indexed Book and include any of more than 15 different types 
of reports.

Computer & DOS Requirements: DOS 3.0 or above, 640K RAM with 540K free

Database Limitations: 32,000 names, 20 children per marriage, 15 marriages per individual

Names: 60 characters max with surnames allowed anywhere in the name - beginning, middle or end. 
Place Names can be up to 60 characters and need only be entered once! They can then be selected 
from a pop-up list forever after!    

Other features include: adoptions, occupations, Soundex Codes, user-definable flags and events (Birth, 
Christening, Death,    Burial, Marriage, LDS and any other user-definable event), source fields, 
Relationship Calculator, Date Calculator, Address List, Scratch Pad Notes    and Industry Standard 
GEDCOM Import/Export.

Individual Notes may be up to 5 pages (300 lines) using on-line text editor.

Reports include: Pedigree (including cascading), Ahnentafel, Poster Pedigree, Descendant, Modified 
Register, Family Groups, Documents, Scratch Pads, User-definable Individual & Marriage Lists, Individual
Summary, Address List, Place List, Mail Labels, Statistics, Time Line,    and Surname Frequency.

An Indexed Book allows you to include all of the reports listed above (except for the Poster Pedigree & 
Mail Labels). The Indexed Book creates an index of all names printed in the book and produces an index 
at the end showing which reports and page numbers where each individual is mentioned.

International Reports: All reports may be printed in the following languages: English, French, German, 
Danish, Spanish, Italian, Norwegian and Dutch.

The 200+ page printed manual    includes the following sections: 
1. Installation & Quick Start 
2. Tutorial 
3. Detailed Reference      
4. DOS for Beginners
5. Climbing Your Family Tree
6. Producing Your Family History Book



Family Photo Album (Windows)
This program does not include a manual. All help is in the on-line help files.

Create your own Photo Albums with this exciting program! With Family Photo Album you can create an 
entire book/album with your scanned photographs. 

* Unlimited number of albums can be created.
* Each album can consist of up to 1,000,000 chapters.
* Each chapter can hold up to 250 scanned images (PCX, BMP, GIF, JPG, WMF, or ICO). If you do not 

own a scanner, Cumberland Family Software will scan your photos for you. (See prices in programs 
help.)

* Each photograph can include a caption.
* Each chapter can also include a large 64,000 character story note. The text editor includes a Spell 

Checker.
* Print out your album with regular or large photographs. You can include a Title Page and Table of 

Contents.
* A sample album is included with the program.



Cumberland Diary (Windows)
Keep your personal diary or journal on the computer

This program does not include a manual. All help is in the on-line help files.

Cumberland Diarys main screen consists of FOUR separate TABS: Contents, Calendar, Diary and Index. 
Each Tab provides you with access to certain features of the program:

 The Contents Tab allows you to search and select diary entries by date.

 The Calendar Tab allows you to search and select diary entries from a perpetual calendar.

 The Diary Tab provides you with a text screen where you type in your diary entries. It includes     
cut & paste, search and spellcheck features.

 The Index Tab allows you to search and select diary entries by heading.

Cumberland Diary includes optional password protection and data encryption.

You may easily import or export to ASCII text files and import your old Cumberland Diary (DOS) diaries.



Cumberland Diary (DOS)
A full-featured diary/ journal entry program. Includes a printed manual of about 70 pages.

* User-friendly pull-down menus and context-sensitive help.
* A word processor with cut and paste features.
* A spell check dictionary (for registered users).
* Optional secrecy mode with password protection and data encryption.
* Headings can be included for each entry. More than one entry per day is
    allowed. Each entry may be up to 10 pages long (6600 words).
* Selections may be made by date or heading.
* ASCII text may be exported or imported, allowing swapping of data with
    other word processors.
* Entries may be printed singly, in groups, or as an entire book. They may
    also be imported by Cumberland Story.
* A multi-entry text search allows you to find embedded phrases within the
    diary entry.
* Allows multiple diaries.



Cumberland Story (DOS)
Write a book about your own or your ancestors life story! Includes a printed manual of about 70 pages.

* User-friendly pull-down menus and context-sensitive help.
* A word processor with cut and paste features.
* A spell check dictionary (for registered users).
* Suggested or user-defined Chapters and Topics with printable Table of
    Contents.
* Imports text from Cumberland Diary for inclusion in your book.
* ASCII text may be imported or exported, allowing swapping of data with
    other word processors.
* A multi-entry text search allows you to find embedded phrases within the
    books chapters and topics.
* Allows creation of multiple books.




